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1 Enterprise Studio 2.6.0 release notes

For whom?

This release is useful for all users.

Attention: Commit all outstanding changes in your Team Server model
packages before updating to Enterprise Studio version 2.6.0.

A list of known issues can be found online in the Enterprise Studio knowledge
base. If you do not have an account for the BiZZdesign Community to access
the knowledge base, you can request one.

Note: The first time a model package is opened in Enterprise Studio 2.6.0,
it is automatically converted for better performance and repair of any
inconsistencies present. Because of this opening the model package may
take a bit longer, but does not affect the model package. After opening the
user can continue working on the model package.

New features and enhancements

The following new features and enhancements have been included in this
release of Enterprise Studio.

General

Enterprise Studio On Demand
As of now, Enterprise Studio On Demand is available, the zero
footprint solution of Enterprise Studio. Enterprise Studio On
Demand is an instant-on solution accessible from any HTML5

https://community.bizzdesign.com/BiZZdesign_Enterprise_Studio_Knowledge_Base/index.htm#knownissues/es_known_issues.htm
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web browser.

Changes in local data storage
To enable faster loading of model packages in Enterprise
Studio, the storage format of model packages has been
changed. When you open a package that has previously been
opened with Enterprise Studio 2.5.0 or an older version, it will
automatically be converted to fit the new storage format.
Depending on the size of the model package, this may take up to
one minute. It is a one time operation and does not affect the
model package.

TP-5099

ArchiMate

New Value stream element*
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The Value stream element has been added to the ArchiMate
metamodel in Enterprise Studio. The Value stream element is
not an official ArchiMate element, but can be of great value for
business architecture.

A value stream describes how an enterprise organizes its
activities to create value. It is a sequence of value-adding
activities that achieve a specific result that is of value to a
stakeholder. Value streams can be defined at different levels of
the organization, e.g. at the enterprise level, business unit level,
or department level.

The Value stream element is included in the ArchiMate Strategy
elements.

The Value stream element is available in the following views:
Capability realization view, Life cycle view, Requirements
realization view, Risk and security view, Roadmap view,
Strategy motivation view (new name), Total view, and Total view
extended.

The introduction of the Value stream element includes a number
of related changes:

l Two new views have been added based on the Value
stream element: Value stream view and the Value
stream realization view.

TP-4074
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l The Capability motivation view has been renamed to Strategy
motivation view to better reflect the kinds of elements that can
be used.

l The name of the Strategy and Capability folder in the model
package's context menu for adding new views, has been
renamed to Strategy to be in line with the types of views that
are in it.

l The Total view extended and Value stream view use the flow
arrow symbol to represent the Value stream element:

For more information about the Value stream element, please
refer to the ArchiMate Modeling Guide.

Import and export

ArchiMate Exchange File Format import support for ArchiMate 3.0*
The ArchiMate Exchange File Format import function in
Enterprise Studio now also supports importing ArchiMate 3.0
models, in addition to ArchiMate 2.1 models.

TP-4657

BiZZdesign Connect: Script optimization scheduled import and export
The generated script for scheduled Excel, ServiceNow® or SQL TP-4988
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imports and exports has been modified such that the parameter
"model" is known within the context of the script. This avoids
potential script errors that were introduced in the last release.

BiZZdesign Connect - Excel: Performance improvement import, reporting optional
The performance of the Excel import has been improved. The
speed of updating large lists of created, modified and matched
objects and relations, which are maintained to generate a report
at the end, has been improved. Generating the report has been
made optional. By default, it is deactivated. It can be activated in
the connection options.

TP-4990

Scripting

Optimization in updating collections
In the scripting language, updating collections that are part of a
Structure value has been optimized for speed. Instead of having
to retrieve a structure collection member and, after updating the
collection, putting the collection back into the structure as a
whole, the collection member can be accessed directly. For
example:

TP-4995
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c = structure.member;
c.add(...);
structure.add("member", c)

may be replaced by:

structure.member.add(...);

Team Platform

Forward proxy for storage place
It is now possible to specify a forward proxy for a storage place.
When adding or changing a storage place at the Enterprise
Studio Options, the proxy settings can be set via the Proxy
settings button in the wizard.

For more information about using a proxy, please refer to the
Team Platform Guide.

TP-4287
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Changes on Team Server user home page
Few changes have been made on the home page of the Team
Server. They include the following:

l The name of the user can be clicked to go directly to the user
details page.

l The list of invitations and list of user groups now show up to 4
items to avoid long lists and scrolling on the page. To view all
invitations and user groups, Show all buttons are available.
When clicking a button, the full list of invitations or user
groups on the user page is shown.

TP-4833

Updated Activity Console log files
The Activity Console log files have been updated. They now
contain the date and time in the file name of the original start
moment of the Activity Console, which is maintained even if the
file rolls over due to a new day starting. This ensures that each
unique run of the Activity Console will log to a separate file,
which improves problem diagnosis.

TP-5029
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Bug fixes

The following issues have been fixed in this release of Enterprise Studio.

General

The previously used version of Inkscape that was used by the
Create poster function in Enterprise Studio contained a
potential security vulnerability. A new version of Inkscape is
included to fix this.

TP-4692

The sample text in the Font dialog at the Enterprise Studio
Option (File > Options > Documentation Window Font Settings >
Edit) displayed some random Chinese-like characters instead of
"AaBbYyZz".

TP-5087

BPMN

A number of errors in the import of certain BPMN models from
other tools, using the standard exchange format, have been
solved. This includes missing data stores, errors in the import of
data objects, missing flows in collaboration diagrams, and
several issues with the layout of relationships.*

TP-4302

BMC

In a Business Model Canvas model, a selected sticky note did
not have the Navigator control, which allows the user to follow
the sticky note's relationships with other parts of the model
package.*

TP-4689

In Business Model Canvas models, the Show implementation
concept control did not work for sticky notes in the "Value
propositions" section of the canvas.*

TP-4947
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Enterprise Portfolio Management

At validation, a metric of score type "automated" kept producing
the warning "metric type unspecified", even though score type,
scoring script, and metric type were correctly specified.*

TP-4695

On a Stakeholder analysis view, changing a stakeholder's
attitude in its property form would incorrectly position its
Navigator, Smart connector, and quick-create controls (until a
refresh was done).*

TP-4718

When an aggregate metric had child metrics that produced non-
numerical timed values without a value mapping, clicking the
aggregate mapping in a properties form would let the form
disappear from view.*

TP-4804

Import and export

When importing from or exporting to Excel workbooks using an
Excel connection, the import or export could stall indefinitely
when the Excel workbook was password protected, freezing
Enterprise Studio. This situation will now produce an error
message and import or export will stop.

TP-3697

Modeling

When adding new objects to a view, Enterprise Studio prompts
when objects with the same name already exist, and offers the
option to refer to such an object. This prompt would also appear
when the new name differs from the old name only in casing.
Also, referring to an existing object would inadvertently also
rename that object.

TP-3219
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Scripting

When a script tried to auto-layout a diagram using non-default
settings (i.e. by forwarding a structure containing those settings)
it crashed the application.

TP-4901

Team Platform

The Check and repair function incorrectly repaired objects
"without a parent", sometimes leading to a model package state
where changes could no longer be saved and committed until
all changes were rolled back first.

TP-4468

When the license seats are exceeded, the seat count could not
be reduced by removing the designer role of users.

TP-4649

When updating a project with contributions from its master
model package (via Update Project) while there were also
older contributions available (on the Update tab) from another
user's project update, the working copy became inconsistent. It
looked as if the older contributions (from the Update tab) were
implicitly updated too, but they were not.
From now on, the older contributions from the master model
package available on the Update tab will also be shown and
updated via Update Project.

TP-5032

Reverting a model package when the claims of a user were
removed would not only revert the commits and uncommitted
changes affected by the removed claims, but also any new
commits the user had updated with, which could after that not be
updated anymore on the local working copy of the model
package.
Also, sometimes the message "Your model package will revert
to the last synchronized contribution." would keep popping up,

TP-5171
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even after suspending contributing to the model package.

Sometimes no names for models were shown in the Team
Server, caused by invalid information in the commit created by
Enterprise Studio. In order to make the model names show up
again in the Team Server, one commit must be made with a new
model, or with an updated model name in the project.

TP-5181

* The issue has resulted in a changedmetamodel configuration. If you havemodel
packageswith thismetamodel embedded (.xmam) and/or model packages stored in
your personal storage or on the TeamServer (TeamPlatform), you need tomigrate
them tomaterialize the change or fix in this release. For instructions, please refer to
the Enterprise Studio Update Guide.

Last updated: 2018-01-24
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2 Enterprise Studio 2.5.0 release notes

For whom?

This release is useful for all users.

A list of known issues can be found online in the Enterprise Studio knowledge
base. If you do not have an account for the BiZZdesign Community to access
the knowledge base, you can request one.

New features and enhancements

The following new features and enhancements have been included in this
release of Enterprise Studio.

General

Storage of Enterprise Studio and Activity Console settings
As of this release, Enterprise Studio no longer uses the
Windows registry for storing the application's and Activity
Console settings. The settings are now stored in files in the
user's profile (or another user-defined location).

TP-4419

Application logging extended
The Enterprise Studio application logging now allows logging
information about the Enterprise Studio startup sequence.

TP-4880

ERD

NIAM view for object-role modeling*
A new NIAM-like (Natural language Information Analysis
Method) view is available for entity-relationship modeling. It is a

TNG-
6408

https://community.bizzdesign.com/BiZZdesign_Enterprise_Studio_Knowledge_Base/index.htm#knownissues/es_known_issues.htm
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variation of the Crows Foot notation inspired by NIAM
(Conceptual Schema and Relational Database Design by Sjir
Nijssen & Terry Halpin (1989)). In particular the notion of fact
(type) is introduced to model relationships. A fact consists of two
predicates, each defining the role of one of the entities involved
in the relationship.

For more information, please refer to the ERD Modeling Guide.

Modeling keys as objects*
Previously, attributes could be made part of a primary key, but
the primary key itself was not further specified. An entity could
only have one primary key for identification.

As of now, keys can also be modeled as objects by means of the
Key concept. The concept is available in the Crows Foot logical
view. Because keys can be modeled as objects, multiple keys
can be used for identification of an entity. An example:

TNG-
6441
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For more information, please refer to the ERD Modeling Guide.

Sorting function for entity attributes*
Few changes have been made to the sorting of attributes to
improve consistency and make it more logical. From now on,
attributes are automatically sorted ascending on name when
added to the entity. After adding they can be sorted differently by
using the sorting control at the border of the entity. The sorting
function is only available in the Crows Foot logical view.

Additionally, when the attributes are marked as optional (-) or as
part of the primary key (#), the attributes list is automatically
sorted again by the marking. Within each marking type, the
name sorting order is used.

TP-2384



2   Enterprise Studio 2.5.0 release notes

Enterprise Studio Release Notes 18

For more information, please refer to the ERD Modeling Guide.

Entity attributes available in model browser*
To have all objects of an ER view available in the model
browser, attributes are now also available there. Attributes of an
entity can only be created in the view, and after creation they will
be visible in the model browser.

Deleting attributes can be done from the view as well as the
model browser. In both situations they are removed from the
model.

TP-2961

Import and export

BiZZdesign Connect: Information exchange with SQL databases
In addition to data integration with Excel and ServiceNow®, the
BiZZdesign Connect functionality now has a data integration
with SQL databases. This connection allows you to exchange
information from tables in the database with ArchiMate models in
Enterprise Studio, and vice versa.

TP-3907
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To exchange information with a SQL database, SQL queries are
used. SQL database connections are defined and used in a
similar way to Excel and ServiceNow connections.

Option to remove attribute or metric values in Excel and ServiceNow import
When using Data Integration to import from Excel or
ServiceNow, non-mandatory attribute, tagged or metric values
can be reset if the associated sources in the external import file
are empty (for example empty cells in Excel).

To do this, activate the import setting Remove of the relation
between an attribute, tag or metric and the column. It can only be
activated if the import setting Mandatory has been deactivated.

TP-4424
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For more information, please refer to the BiZZdesign Connect
Guide. The documentation currently only covers the Excel
connection.

Licensing

Improved indication software license expiration
When the Enterprise Studio software license is about to expire
or has expired, the software activation dialog is shown when the
tool is started. Few changes have been made to this dialog to
make it more clear for the user that the license is about to expire
or has expired.

In case it concerns a network license, the user no longer has the
option to request a license, and is instead advised to contact the
system administrator.

TP-1740
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InSite Lite reporting feature available in trial license
Before, the feature for generating InSite Lite reports was not
available in the Enterprise Studio trial license, making it
impossible for users to use this feature. Now the InSite Lite
feature is included.

TP-3867

Modeling

Possibility to navigate to relation end points in model browser
For all relations in a model it is now possible to navigate to the
end points of a relation. When expanding a relation in the model
browser, two hyperlinks are shown that allow you to navigate to
the "from" and "to" end points.

TP-2056
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Scripting

New script method findObject
A new script method findObject has been added to values of
type "object", that allows you to fetch an object using its unique
ID (in addition to the getObjectmethod that uses the less unique
combination of name and type to find the object).

For more information about the method, please refer to the
Scripting Reference, topic "getObject, findObject method".

TP-4564

Team Platform

Different procedure for changing team data location
Your team data, used for the Team Platform functionality, is
located on a default location, but can be set to another location if
desired. The way this is done has changed. It is no longer
possible to change the team data location via the Enterprise
Studio Options in Enterprise Studio (Data Storage tab).

TP-4034
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If you want to use a different location for your team data, you
need to configure a Windows environment variable for
registering the alternative location. For more information about
this, please refer to the Team Platform Guide.

Note: If you already use a team data location other than the
default location in your current version of Enterprise Studio,
you do not need to create the environment variable. It will
automatically be created for you when release 2.5.0 is
installed.

Extension of Team Server user roles
The user roles in the Team Server have changed from two roles
(Administrator and Create model packages) to four different
roles, in order to better distinguish different types of roles. The
new roles make a better distinction between permissions to work
on model packages and projects, and managing the Team
Server and its contents. The newly defined roles are Designer,
Lead Designer, Administrator, and System Administrator.

As was also the case with the former roles, it is also possible to
assign a user none of the above roles, giving this user limited
rights.

For more information about the new user roles and permissions,
please refer to the Team Platform Guide.

Howwill existing roles from users be converted into the new
roles?
The way the existing Team Server users with their permissions
will be converted to the new roles after installing Team Server
version 2.5 is shown in the following table:

TP-4041
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Old user role New user role(s)

Administrator System Administrator (including
Administrator),
Lead Designer (including Designer)

Create model packages Lead Designer (including Designer)

None of both Designer

If a user's new role does no longer properly cover the
permissions the user should have, then the user's roles can
easily be changed in the Team Server. The same applies to user
groups. This can only be done by users with the new
Administrator or System Administrator role.

How do the users with their new roles use up the available
license seats?
Only the users registered in the Team Server with a Designer or
Lead Designer role are being included as part of the license
user count. For more information, please refer to the topic "About
Enterprise Studio users and license seats" in the online
knowledge base.

User avatar shown in Enterprise Studio status bar
The user's avatar is now always shown in the status bar of
Enterprise Studio. This way it is always clear with which identity
a model package is opened.

TP-4528

https://community.bizzdesign.com/BiZZdesign_Enterprise_Studio_Knowledge_Base/index.htm#bes/bes_license_seats.htm
https://community.bizzdesign.com/BiZZdesign_Enterprise_Studio_Knowledge_Base/index.htm#bes/bes_license_seats.htm
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In addition, Enterprise Studio uses the user's full name when
creating new models.

Removing project claims in Team Server no longer possible
The possibility to remove all claims of a project in the Team
Server, and thereby reverting the commits made on the project to
the point it was last updated, has been removed because this
would effectively change history.

The alternative way to release the claims of a project without
applying them to the master model package, is either deleting
the entire project, or restoring it to a previous version and then
applying the changes to the model package.

TP-4542

View database settings in Team Server settings
The database settings of the Team Server can now be viewed
read-only via the Team Server settings menu.

The settings are only accessible to users with the System
Administrator role in the Team Server. (After installation of Team
Server version 2.5, former Administrator users are automatically
converted to System Administrator users.)

TP-4578

https://community.bizzdesign.com/Enterprise_Studio_Help_-_EN/index.htm#tmpl/tp_ts_user_roles_rights.htm
https://community.bizzdesign.com/Enterprise_Studio_Help_-_EN/index.htm#tmpl/tp_ts_user_roles_rights.htm
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Status explanation for invalid storage places
Before, when a storage place was invalid for some reason, it
was not shown in Enterprise Studio. For the user it would lead to
guessing and finding out what was wrong. As of now an invalid
storage place will still be shown, with a short explanation of its
status and possible causes.

TP-4593

Team Server showing its version on homepage
The homepage of the Team Server now shows its version. That
way you can easily find out which Team Server version you are
working with.

TP-4617
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LDAP user name displayed on user page in Team Server
For Team Server users imported through an LDAP connection
the username may differ from the e-mail address used to log in
for non-LDAP users. Therefor, for LDAP users a separate
username field is displayed on their user page.

TP-4663

Selection of model packages when adding users removed
Previously, when adding users in the Team Server, it was
possible to select the model packages for which users were

TP-4722
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invited. This option has been removed. When inviting users, only
their e-mail addresses and roles need to be set.

View filters and viewpoints

Using metrics in view filters
When generating a color, label, or highlight view filter in an
ArchiMate model, not only profile properties can be selected, but
as of now also metrics, provided that they are present in the
model. The metrics are located in the Metrics folder in the
selection window.

The example below is a combined color and label view based
on the metric "Application costs".

TP-4514
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Using timed values in color, compare, label and tooltip views
When generating a color, compare, label or tooltip view for views
in an ArchiMate model, it is now possible to use timed values
instead of the standard time-independent values.

To be able to use timed values, the view filter must be generated
on a view with a timeline, like the Roadmap view. The view must
contain objects with timed values that can be set in an object's
properties form.

In the generated view, moving the timeline pointer will show the
timed values. Example of a color view based on timed values:

TP-4515
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For more information about using timed values in view filters,
please refer to the Time Modeling and Analysis Guide.

Bug fixes

The following issues have been fixed in this release of Enterprise Studio.



2   Enterprise Studio 2.5.0 release notes

Enterprise Studio Release Notes 31

General

When the Enterprise Studio application window would get too
small in height, the lower located commands in the Backstage
view would get out of sight.

TP-2308

When using Enterprise Studio on a second screen, various
pages from the Backstage view would grow too wide, resulting
in unnecessary scroll bars, unreachable out-of-view buttons, etc.

TP-3510

Files could not be opened from network shares. TP-4562

DMN/TDM

After converting a TDMmodel to DMN, hyperlink objects
referring to objects within the original TDMmodel would still
point to those TDM objects instead of their counterpart in the
new DMN model.*

TP-4805

Enterprise Portfolio Management

On a Stakeholder goals view, the standard text "Click and briefly
hold down..." that is displayed on an empty canvas would
remain there even if the stakeholder-goals table was present,
and it would overlap the table, hindering interacting with it.*

TP-4719

ERD

The triangles indicating the direction of relations in ERD and
UML diagrams were not pointing in the right direction in
generated InSite Lite reports, and created PDF, EMF or SVG
posters.*

TP-1622

Editing the name of a relation between two ERD entities via the TP-1883
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relation's Properties window did not work; changes were not
visible in the view where the relation is located.*

When two entities have a relation in between them, it was not
possible to link a key to attributes in both entities.*

TP-2232

The direction of relations in an ER-model was shown incorrectly
when creating a poster (PDF, EMF, SVG), reporting to InSite
Lite, or creating vector-based files via a script.*

TP-4598

Import and export

Without a BiZZdesign Connect license, the import and export
controls on a Connection view could be still clicked, but then
nothing happened (due to the missing license).

TP-3636

If the Excel connection setting Collection separator symbol
was set to its default value (a comma), and a different separator
symbol was used in Excel, the separator symbol from Excel
would be used for the connection instead of the one from the
connection settings.

TP-4573

Licensing

The BiZZdesign Connect functionality was inadvertently
activated in the Enterprise Studio Pro-BPM and Pro-EAM tool
packages.

TP-3637

Metamodeler

The Metamodeler would not store default values of string-typed
attributes correctly. It would remove the single quotes that were
required. The Metamodeler now accepts unquoted strings for

TP-3494
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string-typed attributes, making the quotes optional. For complex
typed attributes, e.g., List of string, the quotes are still required to
be able to parse these values correctly.

Changes made in the Metamodeler with respect to the order of
the values of an enumeration type, were not correctly taken into
account during a migration of a configuration.

TP-4558

Modeling

When cross-model relations had one or more end points that are
in unloaded clusters, the model browser showed question
marks "??" as the object names. Related new feature:
"Possibility to navigate to relation end points in model browser".

TP-2056

In locations where profile attributes or structure members are
listed, their order could vary depending on the way these were
defined in the configuration, stored with the model package,
and/or retrieved from that model package. Now they are always
ordered alphabetically by (localized) name.

TP-2670

Several scenario's of using the Save as function would lead to
corrupted model packages. One scenario was repeatedly
saving a model package to an XMAM file. Another scenario was
saving a model package to a local storage or a Team Server.

TP-3573

When a relation of a certain type ended on another relation, and
this type was set to be turned into a graphical composition,
executing the Generate view command would crash Enterprise
Studio.

TP-4050

Strange characters would sometimes appear in documentation
texts when these texts reached a certain length.

TP-4162

Sometimes Enterprise Studio crashed during execution of the TP-4191
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compare function.

After moving the end point of a relation to another object, any
relations that end in this relation would disappear from the
model.

TP-4327

The Navigator pane and the window for selecting attributes
when generating a view filter (like a color view) did not show the
profiles and profile attributes for relations.

TP-4524

The Navigator pane would show a view multiple times if the
navigated object is present on that view multiple times. Also the
views were not sorted in the correct order.

TP-4658

Reporting and printing

The RTF report would often include information about more
objects than selected on the Diagrams tab of the Generate
report window, resulting in a larger document than expected.

TP-4319

When creating a poster or an InSite Lite report of a UML or ERD
diagram, some of the arrows on the relations did not have the
right direction.

TP-4372

When viewed in Internet Explorer, clicking an object in an InSite
Lite report would not jump to the object's web page.

TP-4554

In some cases malformed links in documentation text could lead
to a crash when an HTML report was generated.

TP-4673

Team Platform

It was not possible to start the Team Server without having a
license. From now on the Team Server will always start up,
even if there is no valid license. Only the working together

TP-3379
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features are disabled in case there is no license, or in case
there are not enough seats.
To view the current state of the license, new license settings are
available in the Team Server settings menu. This menu is only
accessible to users with the System Administrator role.

When committing changes in a project, the commit page in the
Backstage would show the text "Commit your changes to the
model package".

TP-4308

It was not possible to uninvite a user (revoke invitation) from a
project through the project page in the Team Server.

TP-4473

When logged in as a user without administrator rights, and
viewing a user group one is member of, the message 'You do
not have permission to view this content' was given when there
were no invitations for the user group.

TP-4485

In Internet Explorer the preview of the LDAP user import could
show the wrong (previous) results.

TP-4493

A user group could not be renamed if only changes were made
in capital and small letters.

TP-4516

It was not possible to change a storage place without an active
connection, or to remove a storage place without an active
connection. Now it is possible again, but please take note of the
following:
All model packages must be suspended from contributing
before the removal can be done, which can also be done
without an active connection. Forcing the removal of a storage
place may result in the permanent loss of commits that have not
been synchronized yet, and may leave claims and checkouts
active on the Team Server, which must be manually removed on
the Team Server by the user or an administrator.

TP-4540
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When a user had the ability to create projects, but did not have
administrator rights in the Team Server, the user could not
manage the models inside a project.
As of release 2.5.0, only users with the ability to create projects
can manage models in a project. With the newly defined roles, it
means that only users with the Lead Designer role can do this.
Users with the Designer, Administrator, or System Administrator
role will not be able to manage models in a project.

TP-4662

When undoing changes in a model package that is saved in the
user's personal storage via File > Timeline > Undo Changes,
an error was written to the Activity Console log.

TP-4722

The data integrity checks done by the Activity Console upon
starting were too strict, resulting in an error message saying that
the Activity Console is not running or not responsive, or that the
version is incompatible, when starting Enterprise Studio.

TP-4853

UML

The default cardinality between two classes was 0..1, which
was incorrect according to the UML standard. As of now the
default cardinality is set to 1..1. In addition the following
improvements have been made:

l The cardinality is no longer treated as default value, and is
now always shown.

l A single value may be entered for the cardinality, which
implies the lower and upper value are the same (except for
the value *).

l When entering the cardinality, an empty value may be
entered. This means that the cardinality is reset to 1..1 and
not shown. In case 1..1 or 1 is entered explicitly, the

TP-2847
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cardinality is shown.*

View filters and viewpoints

Several color view and label view ribbon commands that ask
the user for input when executed, asked for input again at every
view refresh or when an autosave was done.*

TP-3780

A saved viewpoint generated with the Generate view function,
for which one or more of its selection objects was afterward
removed from the model, would crash Enterprise Studio upon
clicking Edit viewpoint from the viewpoint's context menu.

TP-4688

* The issue has resulted in a changedmetamodel configuration. If you havemodel
packageswith thismetamodel embedded (.xmam) and/or model packages stored in
your personal storage or on the TeamServer (TeamPlatform), you need tomigrate
them tomaterialize the change or fix in this release. For instructions, please refer to
the Enterprise Studio Update Guide.

Last updated: 2018-01-24
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3 Enterprise Studio 2.4.0 release notes

For whom?

This release is useful for all users.

Attention: Users who use HTTPS in their Team Server configuration, need
to update the configuration file for this release. Please read the release
note item "Team Server configuration file update needed if using HTTPS".

A list of known issues can be found online in the Enterprise Studio knowledge
base. If you do not have an account for the BiZZdesign Community to access
the knowledge base, you can request one.

New features and enhancements

The following new features and enhancements have been included in this
release of Enterprise Studio.

ArchiMate

New approach to life cycle management*
Until now, life cycle management in ArchiMate models was
supported via the "Life cycle" profile. This profile distinguishes
four life cycle phases: In development, In use, Out of date, and
Out of use.

Now Enterprise Studio also supports another approach which
offers you the possibility to define and maintain (many) plateaus.
Characteristics of the new approach are:

l A base life cycle management profile that defines a life cycle

TP-3839

https://community.bizzdesign.com/BiZZdesign_Enterprise_Studio_Knowledge_Base/index.htm#knownissues/es_known_issues.htm
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attribute that represents the "current" life cycle phase or stage
of an object.

l This profile can be specialized to define different life cycle
phases for different types of objects.

l Additionally, the profile allows you to define dependencies
between life cycle phases of different (types of) objects.

l To model the evolution of an object's life cycle over time, a
time dimension is available.

For more information about the properties form, please refer to the Time
Modeling and Analysis Guide.

Properties form for ArchiMate objects with metric and time dimension support*
In addition to the existing Properties pane, an additional
properties form is available for ArchiMate objects and relations,
which offers additional features. The new properties form
supports adding metrics and including a time dimension. The

properties form can be accessed by clicking the control that
is available on an object or relation.

TP-4183
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For more information about the properties form, please refer to
the ArchiMate Modeling Guide.

BMC

Visual changes in Business Model Canvas*
A number of visual changes have been made in the Business
Model Canvas to make it look more attractive and give it a more
modern look. The main changes include the following:

l New icons for the sections, both on-canvas and in the model
browser.

l New icons for controls of sticky notes and sections.

l New font for the sections of the canvas.

l New font and position of the title.

l New shape and appearance of sticky notes.

New look:

TP-3555
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Old look:

DMN/TDM

TDM functionality deactivated, conversion to DMN needed*
As of release 2.4.0, The Decision Model (TDM) has been TP-3181
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deactivated in Enterprise Studio, meaning that:

l You cannot create new TDMmodels anymore. The TDM
metamodel in the menu File > New is no longer available.

l Your existing TDMmodels can only be opened read-only, and
when opened, the TDM ribbon tab is no longer available.

As already communicated in the 2.2.0 release notes, the new
Decision Modeling Notation (DMN) is available as a
replacement.

You need to convert your existing TDMmodels to equivalent
DMN models if you want to continue working with them. To do
this, follow the instructions from the TDM to DMN Conversion
Guide.

If you are having trouble converting your TDMmodels or if you
have any questions regarding the conversion, please contact the
BiZZdesign service desk at servicedesk@bizzdesign.com, or by
phone: +31 - 53 - 4 878 171.

Import and export

Scheduling periodic Excel and ServiceNow® imports and exports
The BiZZdesign Connect feature has been extended with a
function for scheduling periodic Excel or ServiceNow® imports
and exports, without user interaction.

TP-3902

mailto:servicedesk@bizzdesign.com?subject=TDM to DMN script
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To activate this, a command-line script can be generated, which
can be used as an argument when calling Enterprise Studio
from the command-line, or when scheduling a periodic task, e.g.,
by means of the Windows Task Scheduler.

For more information, please refer to the BiZZdesign Connect
Guide. The documentation currently only covers the Excel
connection.

Attention: The feature can only be used in local client
installations of Enterprise Studio. It cannot be used in
Enterprise Studio Online, the hosted solution.

Allow deletion of model elements in Excel import
For Excel connections the option has been added to remove
objects from a model (context) during import in case these
objects are not present in the imported Excel table.

The option is available for mapping relations between a meta-
object or metarelation and the mapping table.

TP-4066
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English boolean values always accepted for Excel import
When executing an import in Excel connections, English is now
always accepted as input for boolean values (values Y(es) and
N(o)), regardless of the used model language.

TP-4183

Scripting

New script method addCopyObjectsWithMatching
A new script method addCopyObjectsWithMatching has been
added. It is a variant of addCopyObjects that enables you to
merge the new object copies with objects of the same name and
type that are already present in the target model package.

For more information about the method, please refer to the
Scripting Reference, topic "addCopyObjects,
addCopyObjectsWithMatching method".

TP-3823

New script method keys
The keys script method has been added for "Index" values. The
method returns a list of all the keys in this mapping. For more

TP-3939
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information, please refer to the Scripting Reference, topic "key
method".

Team Platform

Team Server configuration file update needed if using HTTPS
If you are using HTTPS for your Team Server installation (using
certificates), you need to update the Team Server configuration
file when updating your Team Server for this release, because
the configuration properties for HTTPS have changed. The
following properties must be changed:

l https.keyStore

l https.keyStoreType

l https.keyStorePassword

For the new property names, please refer to the Enterprise
Studio Installation and Configuration Guide. Please take note
that the Enterprise Studio installation guide and the Team
Server installation guide are from now on merged into one
installation guide.

Note: Changing Team Server configuration file should only
be done by application administrators who are familiar with
installing and configuring software and databases.

TP-2881

Visual changes Team Server
A few visual changes have been made in the Team Server to
improve the interface:

l The square icon (avatar) representing a user or user group

TP-3972,
TP-3973



3   Enterprise Studio 2.4.0 release notes

Enterprise Studio Release Notes 46

(new) is replaced by a round icon.

The change in icons is also visible in Enterprise Studio and in
the Activity Console.

l The model packages, user and user group (new) overview
pages have become lists instead of grids.

Working with Team Server user groups
It is now possible to work with user groups in the Team Server.
User groups can be used to assign Team Server permissions to
groups of users. User groups can be created and edited via
User management > User groups in the Team Server toolbar.

TP-3240,
TP-3701,
TP-3815
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Within a user group, group members can be managed. User groups can be
invited to model packages and projects, in the Team Server and from
Enterprise Studio.

For more information about working with user groups, please refer to the Team
Platform Guide.

Team Server audit logging
The Team Server now supports audit logging. Important events
are logged and stored for easy retrieval and inspection. For each
event a sequential event number is logged, the date and time the
event occurred and the name of the event. Additionally, details of
the events are available and the events are searchable.

TP-3970
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The audit log is only available for users with administrator rights
and can be accessed in the Team Server via Settings > Audit
log.

For more information about the audit log, please refer to the
Enterprise Studio online knowledge base.

Bug fixes

The following issues have been fixed in this release of Enterprise Studio.

General

The tooltips of the Minimize and Restore buttons in the upper
right corner of the Enterprise Studio main window displayed
incorrect texts.

TP-3525

Enterprise Studio failed to open the online help in the web
browser if it was unable to ping the help site.

TP-3904

Dockable windows and tool panes on a second screen were
invisible when the second screen was unavailable in a new tool
session.

TP-3946

Custom menu entries (on the metamodel ribbon tabs) were not
properly initialized, resulting in table and workset output
windows with an erroneous title, such as "(No tooltip label for id
######)".

TP-3958

A crash would occur when clicking OK in the edit window of an
object's property after the model package was automatically
saved while the edit window still was open.

TP-4150

https://community.bizzdesign.com/BiZZdesign_Enterprise_Studio_Knowledge_Base/index.htm#teamplatform/ts_config/tp_ts_audit_log.htm
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ArchiMate

When opening an old Architect model package in Enterprise
Studio and converting its contents to comply with ArchiMate 3.0,
the conversion of relation types that are no longer supported
would sometimes be accompanied by error messages about
missing attributes. These messages were unnecessary and are
no longer displayed.*

TP-3395

Several elements were missing in ArchiMate views, and have
been made available now:

l Application and Technology Process, Application and
Technology Event, and the physical element have been
added to the Implementation & Migration view and Capability
Realization view.

l The risk and security-related elements have been added to
the Total view and Total view extended.*

TP-4022

BMC

When clicking the Channel Landscape command in the
Business Model ribbon tab, a script error occurred during
creation of the PowerPoint file.*

TP-3032

Enterprise analytics

The scroll bar in the legend of a pie chart (only present in case
of many legend items) did not work anymore.

TP-4168

ERSM

It was not possible to drag or paste certain elements, for TP-3942
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example constraints and implementation and migration
elements, on an ArchiMate Risk & Security view. This is now
allowed.*

Import and export

In a Connection model, it was possible to drag a table or
mapping outside an Excel or ServiceNow connection, or paste a
table or mapping on the canvas or a view graphic.

TP-3779

When exporting an Excel connection table again to the same
file with the Replace formatting option inactive, the Excel
worksheet would still lose its table style and other formatting.

TP-4053

Language and translation

In some languages at start-up of Enterprise Studio, the splash
screen displayed special characters incorrectly.

TP-3990

Lean

Clicking the Lean coach icon in the center of a Lean starting
view would not show the help page.*

TP-3208

Licensing

During activation of the Enterprise Studio license, the error
"Cannot create update from an old CmActLicense context"
would sometimes appear. The licensing software has been
upgraded to fix the error.

TP-3282

When entering a license activation code for Enterprise Studio,
the confirmation message window displayed by the activation

TP-3947



3   Enterprise Studio 2.4.0 release notes

Enterprise Studio Release Notes 51

wizard sometimes contained strange characters.

In some cases inviting users (Team Platform functionality)
resulted in an error message for the taken license seats:
"Unable to take licenses. License is invalid."

TP-4029

Metamodeler

If a user had no outstanding changes, but might have had
claims that needed to be released first when applying
metamodel changes to the original model package, an unclear
message would appear. This message has been adjusted to
better inform the user.

TP-3212

Modeling

When copy and pasting inside a table, previously unquoted
texts would be pasted with closing quotation marks.

TP-3705

Deleting a graphic name label would also reset the semantic
name of the object (in the object's properties window).

TP-3902

The ArchiMate Roadmap view, on which the auto-layout cannot
be performed (for good reasons) via the ribbon or by pressing
F6, could still be laid out using the script method
autoLayoutDiagram.

TP-4163

When an object on a Roadmap view was collapsed and resized
in its expanded view, the object was also resized on the
timeline, changing begin and end dates.

TP-4218

Reporting and printing

In an InSite Lite report, hyperlink objects nested in other objects TP-3610
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would not open their link when clicked on, but instead jump to
the objects the hyperlink was nested in.

Scripting

Moving a model object to under a model package or a model
package folder from within a script (moveTo method ) was not
possible.

TP-2409

The addCopyObject script method refused to copy objects from
other model packages that use their own embedded
configuration (e.g. '*.xmam' or tracked/shared model packages).

TP-2952

The workset script function did not accept its mandatory
parameter, resulting in a script error.

TP-3869

Team Platform

In tracked and shared model packages, profile values of type
"GUID" would change every time the model package was
closed and reopened.

TP-4195

The Activity Console did not perform decent data integrity
checks upon starting, because of which corrupt data files could
go unnoticed.

TP-4242

The configuration of the Team Server was logged in the
application log, which would expose passwords in the log.

TP-4277

In some cases, the local working copy of a shared model
package could get corrupted after updating it, leading to
unexpected crashes.

TP-4320

After changing the Team Data location to a folder on a share,
Enterprise Studio would no longer be able to access local and

TP-4321
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remote storages, claiming that the Activity Console is not
running.

* The issue has resulted in a changedmetamodel configuration. If you havemodel
packageswith thismetamodel embedded (.xmam) and/or model packages stored in
your personal storage or on the TeamServer (TeamPlatform), you need tomigrate
them tomaterialize the change or fix in this release. For instructions, please refer to
the Enterprise Studio Update Guide.

Last updated: 2018-01-24
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4 Enterprise Studio 2.3.3 release notes

For whom?

This release is important for customers in Latin language speaking countries
(i.e. Spanish, Portuguese, French, Italian).

Bug fixes

The following issues have been fixed in this release of Enterprise Studio.

Team Platform

The Activity Console could read or store a storage place
anymore when a date was not parsed properly. When this
happened, the Activity Console could not be started anymore.

TP-4024

Last updated: 2017-03-03
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5 Enterprise Studio 2.3.2 release notes

For whom?

This release is useful for all users.

Bug fixes

The following issues have been fixed in this release of Enterprise Studio.

ArchiMate

In an ArchiMate model, it was no longer possible to create a
"Composite elements" element container via the context menu.*

TP-3824

Newly created folders in ArchiMate models were unusable,
because it was not possible to create other objects within them.

Note: If you have created folders with Enterprise Studio
2.3.0, you need to remove these folders and recreate them
with 2.3.2.

TP-3830

Modeling

The auto-layout (performed via Automatic Layout or F6, or
using the Generate view for function) sometimes failed,
reporting a crash of "GraphViz" and an internal error.

TP-3901

Views and viewpoints

Creation of folders and viewpoints via the context menu in the
Viewpoints pane was not possible anymore.

TP-3865
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* The issue has resulted in a changedmetamodel configuration. If you havemodel
packageswith thismetamodel embedded (.xmam) and/or model packages stored in
your personal storage or on the TeamServer (TeamPlatform), you need tomigrate
them tomaterialize the change or fix in this release. For instructions, please refer to
the Enterprise Studio Update Guide.

Last updated: 2017-05-04
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6 Enterprise Studio 2.3.0 release notes

For whom?

This release is useful for all users.

Attention: Users who work with the Team Platform functionality "Working
together" or "Working together in projects" (Advanced or Enterprise
package), please read the release note item "Change in Team Server
password storage requires reentering storage place credentials".

A list of known issues for this release can be found online in the Enterprise
Studio knowledge base. If you do not have an account for the BiZZdesign
Community to access the knowledge base, you can request one.

New features and enhancements

The following new features and enhancements have been included in this
release of Enterprise Studio.

General

Enterprise Studio help now only online
The help function in Enterprise Studio has changed from an
offline help to online help. That way the user always has the
latest help for the tool. The online help is located in the
BiZZdesign Community.

TP-3355

https://community.bizzdesign.com/BiZZdesign_Enterprise_Studio_Knowledge_Base/index.htm#knownissues/es_known_issues.htm
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To be able to access the online help, you need an internet
connection and an account for the BiZZdesign Community. If
you do not have an account yet, you can request one. Read this
article for more information.

If you want to be able to browse the documentation also offline,
you can download a ZIP file containing PDF guides.

New feature Customer Journey Mapping*
Enterprise Studio now supports creating customer journey maps
for ArchiMate models. A customer journey map is a useful way to
represent the experience of an individual while interacting with
an organization, service, or product, over time and across
channels. It focuses on the customer interaction and helps you
optimize this experience.

TP-3647

http://tiny.cc/EnterpriseStudioManuals
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The customer journey mapping feature is available in the
Enterprise Studio Advanced and Enterprise package.

For more information, please refer to the Customer Journey
Mapping Guide.

ArchiMate

Reorganized ArchiMate views context menu*
The context menu for adding new views to an ArchiMate model,
folder or view has been reorganized to give a better overview of
the various options. The views are now organized by the
language structure.

To access the context menu, right click an ArchiMate model,
folder or view, point to New, and select the view of your choice.

TP-3111
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ERSM

Improvements in security profile values propagation*
Several improvements have been made in the propagation of
security profile values in a model when activating a color view in
a risk and security view for these values. They are:

l With a Use relation, the values also propagate in the opposite
direction.

l If an element is associated with a relation, its value can
propagate to both end points of the associated relation.

l In addition to firewalls, all nodes that are part of a network
(with aggregation or composition) are considered network
elements.

TP-3651
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Import and export

BiZZdesign Connect: Information exchange with ServiceNow®

The BiZZdesign Connect feature has been extended with the
possibility to exchange information from ArchiMate models in
Enterprise Studio with information from tables in the
ServiceNow® platform.

Exchanging information between Enterprise Studio and
ServiceNow globally includes the following steps:

1. Create a connection to represent the information that is
exchanged between Enterprise Studio and ServiceNow, by
creating a Connection model with a Connection view,
including a ServiceNow connection.

2. Define the connection by creating one or more tables to
organize the information.

3. Validate the connection and its tables.

4. Execute the connection in a direction: import (data exchange
from ServiceNow to Enterprise Studio) or export (data
exchange from Enterprise Studio to ServiceNow).

TP-3620
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Note: The information exchange with ServiceNow feature is
currently in a beta testing phase. You are welcome to try it out
in your test environment, but be careful when using it in your
production environment. Any models you create using the
ServiceNow feature may not be usable in the next version of
Enterprise Studio.

Modeling

Last used modeling language/method remembered for creating new model package
Enterprise Studio now remembers the modeling language or
method (metamodel) of the template that was last used for
creating a model package. Before, ArchiMate was always the
default selected modeling language.

As a result of this, you can now directly select a template or
example model when creating a new model package. The last
used modeling language or method will automatically be
selected.

TP-3065
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Relation cross-reference table between relations
It is now possible to open a relation cross-reference table
between relations, that is, a cross-reference table with relations
that have another relation as their start or end point.

This is useful for a metamodel such as ArchiMate, where a
Plateau uses the Aggregation relation to define which elements
(including relations) are part of the Plateau.

TP-3658

Scripting

Array operator [ ] available for fetching value from Index
In a script, the array operator [ ] now may also be used to fetch a
value from an Index (as an alternative to valueFor). Example:

value = index[key];

For more information, please refer to the Scripting Reference,
topic "Expressions".

TNG-
5764

Option to continue script execution on errors in external object
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The scripting language has been extended with the ability to
ignore errors in external objects, to enable a script to handle
these errors itself.

For more information, please refer to the Scripting Reference,
topics "session statement" and "getError, hasError, clearError
method".

TP-3682

Team Platform

User import from Active Directory and single sign-on access out of beta
The functionality for user import from Active Directory and single
sign-on access, which was still in beta testing phase in release
2.2.0, is now fully functional.

For the latest information about LDAP user import and single
sign-on, please refer to the Team Server installation and
configuration documentation.

Name and e-mail address LDAP users read-only
The user's name and e-mail address on the user page of the
Team Server cannot be edited anymore if it is a user that is
synchronized with LDAP. Also, users that are synchronized with
LDAP cannot be removed via the user page anymore.

TP-3351

Preview LDAP user synchronization results
Before synchronizing users from Active Directory with LDAP, a
preview is shown of the results of the LDAP query. The preview
shows how many users will be added, changed, and/or removed
when the synchronization is performed.

If the results are not as expected, the LDAP query can be
changed before performing the actual synchronization.

TP-3352
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The user synchronization can be accessed via the Active
Directory Integration Settings page of the Team Server.

Note: The Team Server settings can only be accessed by
administrator users. They are not visible to other users.

LDAP authentication for Team Server login
If LDAP is configured on the Team Server, users can
authenticate using their Windows username and password
when logging in to the Team Server.

With the LDAP authentication available, the configuration for
using single sign-on is now optional.

TP-3407,
TP-3578
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LDAP import deactivation improvements
When deactivating the LDAP import, the user now has the
choice to remove the LDAP users, or to keep them. If the users
are kept, they will be converted to original Team Server users.
After the conversion, the former LDAP users will receive an e-
mail to set their new password for the Team Server.

TP-3503

Invite only existing Team Server users
The Team Server settings have been extended with the option
that only existing users can be invited to model packages and
projects.

Users who are registered in the Team Server can invite other
people to collaborate on model packages and projects. By
default, anyone can be invited.

For security reasons, inviting people can be limited to users who
already exist in the Team Server. These are people that have
been added to the Team Server by an administrator user and
have received an invitation to register. They need not have
registered yet though.

The limitation on inviting users can be set on the General
Settings page of the Team Server.

TP-3600
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If the option is activated, new Team Server users can only be
added by an administrator user.

Note: The Team Server settings can only be accessed by
administrator users. They are not visible to other users.

Change in Team Server password storage requires reentering storage place credentials
The Activity Console no longer stores passwords to connect with
the Team Server. It uses cookies instead. As a result of this
existing storage places will fail to connect, because there is no
cookie available yet. The Activity Console will also point this out
by indicating that a specific storage place could not be synced.

To resolve this, the user needs to update each storage place
connection in Enterprise Studio by reentering the credentials for
the storage place. The storage places can found on the Storage
Places tab of the Enterprise Studio Options (File > Options).

TP-3604
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Change Team Server configuration settings
The Team Server configuration settings that are set during the
Team Server installation process, can now be changed if
desired. Previously this was not possible.

Team Server identification details can be changed on the
General Settings page of the Team Server, the Team Server e-
mail configuration can be changed on the E-mail Settings page.

TP-3617
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Notes: Changing Team Server settings should only be done
by application administrators who are familiar with installing
and configuring software and databases.
The Team Server settings can only be accessed by
administrator users. They are not visible to other users.

The database configuration can only be changed in the
configuration file of the Team Server.

For more information about changing Team Server settings,
please refer to the Team Server installation and configuration
guide.

Bug fixes

The following issues have been fixed in this release of Enterprise Studio.

Amber

Moving an existing Amber enable relation (and its end points)
onto a sub-process, or drawing a new sub-process around them,
would result in the enable relation data being corrupted.*

TP-3333

In Amber models, deleting objects from a collapsed sub-process
was not always allowed.*

TP-3759
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ArchiMate

It was not possible to add specialization relations between
Equipment, Facility and Node objects. Further, Grouping and
Plateau objects could not have aggregation or composition
relations to junctions.*

TP-3187

It was not possible to add composition, aggregation and
assignment relations to the ArchiMate Capability Motivation
view.*

TP-3433

With the Difference between views function on the ArchiMate
ribbon tab, the user would be asked periodically to re-enter the
views to compare.*

TP-3434

BPMN

In BPMN models, deleting objects from a collapsed sub-process
was not always allowed.*

TP-3759

DMN

When adding a condition to a DMN decision table, the object
selection window would ask to select a "DMN_
ConditionElement", instead of a Decision or Input data object.*

TP-3530

Names with hard line breaks of elements in a DMN decision
requirements diagram were sometimes not displayed correctly.*

TP-3554

The DMN functions DAY(), MONTH() and YEAR() incorrectly
returned 0 when called with an information item or expression.*

TP-3580

Adding a condition to a decision table would not add the
associated input data element to the decision requirements
diagram when this was in listed display mode.*

TP-3581
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Clicking the Set as list type control in the DMN glossary for an
information item of a decision or business knowledge model
without an attached decision table, generated a script error
message.*

TP-3574

When copying content, or creating an Excel report of a DMN
model, numeric values were exported as strings, which gave the
wrong results in case a comma was used as a decimal
separator in Excel.*

TP-3673

ERSM

The color view for security profile values in a risk and security
view did not work properly if the model language was set to
Dutch.*

TP-3671

Import and export

BiZZdesign Connect: The names of objects in the row and
column headings were not imported when importing a cross
relation table.

TP-3652

BiZZdesign Connect: The export of cross-relation tables could
be incomplete in case the last row(s) did not contain relations.
Further, the definition of the source context on the mapping
relation was not taken into account.

TP-3676

Language and translation

Switching the active model language while editing
documentation could in some scenarios result in a
documentation text for one language being replaced by the text
for another language.

TP-3396
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Modeling

Deleting a model from a model package while the Viewpoints
pane is showing its viewpoints could crash the application.

TP-3227

When copying from a Query tool result table (using Ctrl+C or the
Copy button), not only the selected grid cells were copied, but
also the associated header cells. The Copy + button has been
added for this behavior, and the Copy button now only copies
the grid cell values.

TP-3533

When defining a relations cross-reference table between the
same object types (for example, from business processes to
business processes, via a triggering relation), the relations were
shown double.

TP-3659

It was not possible to copy data from theWorksets window for
use in external applications. Now, the data is copied to the
Windows clipboard and can be pasted in external applications.

TP-3699

Reporting and printing

The left side bar of an InSite Lite report, containing a list of
diagrams, was not scrollable.

TP-3592

Scripting

Sometimes the Query tool would show illegible warning texts. TP-3661

Team Platform

The passwords for the database, the e-mail server, the LDAP
server and single sign-on were not encrypted when stored in the
configuration file of the Team Server.

TP-3273
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When the setup of a new Team Server was carried out, the Use
integrated security for database connection setting on the
setup page was not stored after clicking Finish setup.

TP-3489

When a user was removed by synchronizing with LDAP, the
invitations and claims of this user were not removed.

TP-3576

When the e-mail address of a user was changed, its login name
was not changed accordingly. The user would then still need to
use the old login name to log in to the Team Server.

TP-3639

Using single sign-on (SSO) for the Team Server without using a
Keytab file was not possible.

TP-3643

While creating objects in a view using the quick-create pop-up
window, Enterprise Studio could crash in some occasions,
when the connection with the Team Server got lost.

TP-3644

The server ID of the Team Server was not initialized properly
after setting up the Team Server. It was only initialized after
restarting the Team Server. When the Activity Console would
connect with this Team Server before the first restart, connecting
with this Team Server after it had been restarted was not
possible anymore.

TP-3764

* The issue has resulted in a changedmetamodel configuration. If you havemodel
packageswith thismetamodel embedded (.xmam) and/or model packages stored in
your personal storage or on the TeamServer (TeamPlatform), you need tomigrate
them tomaterialize the change or fix in this release. For instructions, please refer to
the Enterprise Studio Update Guide.

Last updated: 2018-02-23
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7 Enterprise Studio 2.2.1 release notes

For whom?

This release is important for users who work with the Team Platform
functionality "Working together" or "Working together in projects" (Advanced or
Enterprise package), and have problems with the Activity Console.

Bug fixes

The following issues have been fixed in this release of Enterprise Studio.

Team Platform

The Activity Console could not be started by admin users. TP-3677

Last updated: 2017-03-03
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8 Enterprise Studio 2.2.0 release notes

For whom?

This release is useful for all users.

A list of known issues can be found online in the Enterprise Studio knowledge
base. If you do not have an account for the BiZZdesign Community to access
the knowledge base, you can request one.

New features and enhancements

The following new features and enhancements have been included in this
release of Enterprise Studio.

General

Enterprise Studio 64-bit release
Enterprise Studio is now available as a 64-bit release. It allows
you to build and use larger model packages.

If you are not working with 64-bit computers, a 32-bit version is
available. Please contact the BiZZdesign service desk at
servicedesk@bizzdesign.com, or by phone: +31 - 53 - 4 878
171.

TP-3323

Enterprise analytics

Use table chart for populating other charts
A table chart can now be used to define the population of (other)
charts. To be able to use a table chart, the chart population
selection control has changed from a single control (+) to two
controls, one for selecting objects and one for adding table

TP-3223

https://community.bizzdesign.com/BiZZdesign_Enterprise_Studio_Knowledge_Base/index.htm#knownissues/es_known_issues.htm
mailto:servicedesk@bizzdesign.com?subject=TDM to DMN script
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charts.

To enable a table chart to be selected for populating another
chart, it must be in selection mode. The table chart has the
control to activate the selection mode.

When in selection mode, the elements that must be included in
the population can be selected.

Color scheme changes for charts
Few changes have been made to the available color schemes
for charts. The "Waveform" color scheme is now the default color

TP-3457
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scheme for charts (this was "Business").

Additionally, the "BiZZ" color scheme has been added to
facilitate the use of the BiZZdesign colors.

Import and export

Information exchange between Enterprise Studio and Excel
As first feature of the new BiZZdesign Connect functionality, it is
now possible to exchange model information between
Enterprise Studio and Microsoft Excel files. Model data can be
imported from Excel into Enterprise Studio, but also exported for
exchange in the opposite direction. Currently, information from
ArchiMate and entity-relationship models ( ERD) can be
exchanged.

TP-1837
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Exchanging information between Enterprise Studio and Excel
globally includes the following steps:

1. Create a connection to represent the information that is
exchanged between Enterprise Studio and a single Excel
file, by creating a Connection model with a Connection view,
including a workbook.

2. Define the connection by creating one or more tables to
organize the information in worksheets. A table represents
the mapping between object types and properties in
Enterprise Studio and the columns, rows, and cells of a
single worksheet in the Excel file.

3. Validate the connection and its tables.

4. Execute the connection in a direction: import (data exchange
from Excel to Enterprise Studio) or export (data exchange
from Enterprise Studio to Excel).
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Scripting

New methods for getting/setting relation line segment (percentage)
The scripting language has been extended with new methods
regarding getting and setting of the line segment and line
segment percentage for attaching a relation on another relation.
They are:

l fromLineSegment
l toLineSegment
l (re)setFromLineSegment
l (re)setToLineSegment
l fromLineSegmentPercentage
l toLineSegmentPercentage
l (re)setFromLineSegmentPercentage
l (re)setToLineSegmentPercentage

TP-3188

New method id() for object value
An object value in the scripting language now has a new method
id() that returns its unique identifier as a string. In tracked and
shared packages, this is a GUID. In unsaved or file-based model
packages (XMA, XMAM) the object's local ID is returned (for
example a number).

TP-3281

TDM

Decision Model and Notation (DMN) replaces TDM*
New functionality for modeling business decisions and business
logic based on the OMG standard DMN (Decision Model and
Notation) has been added to Enterprise Studio. The DMN
functionality will replace The Decision Model (TDM)

TP-3181
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functionality, and includes the following:

l Graphical modeling of a decision in a Decision Requirements
Diagram (DRD), including decisions, input data, business
knowledge models and knowledge sources.

l Specification of business logic in decision tables, with
specified hit policies.

l An expression language, based on the FEEL expression
language of DMN, to be used in decision tables.

l Boxed invocations of reusable decision tables linked to
business knowledge models.

l A glossary to define and manage information items.

l Simulation and batch testing of decisions.



8   Enterprise Studio 2.2.0 release notes

Enterprise Studio Release Notes 81

Note: For customers working with the TDM functionality: To
continue working with your TDMmodels in DMN, your TDM
models need to be converted to equivalent DMN models.
Please contact the BiZZdesign service desk for more
information and instructions at servicedesk@bizzdesign.com,
or by phone: +31 - 53 - 4 878 171.

Team Platform

Restoring model packages and projects
It is now possible to revert a model package or project to the way
it looked at an earlier point in time by restoring it. Restoring can
be done in the timeline of the model package or project.

When restoring, all changes committed after the chosen point in
time will be removed from the model package or project.

Basically, the restore function is available on each contribution
in the timeline. However, if a model package has been updated

TP-3298

mailto:servicedesk@bizzdesign.com?subject=TDM to DMN script
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with a configuration migration at some point in time, the model
package can only be restored to a point in time after the
contribution containing the last configuration migration.

Please refer to the Enterprise Studio Team Platform
documentation for more information about the restore function.

User import from Active Directory and single sign-on access
The Team Server can now be populated with users by importing
them fromWindows Active Directory using LDAP.

Additional to the LDAP user import, it is possible to use single
sign-on to access the Team Server and in Enterprise Studio to
add, edit and remove storage places. Single Sign-On supports
users to gain access with their Windows account without giving
their credentials.

Please refer to the Team Server installation and configuration
documentation for more information about LDAP user import and
single sign-on.

Note: LDAP support is currently in a beta testing phase. You
are welcome to try it out in your test environment, but be
careful when using it in your production environment. Once
you have activated LDAP user import and imported users,
user accounts will be converted and this can currently not be
undone. Working with this feature requires Enterprise Studio
2.2.0.

TP-3402

Bug fixes

The following issues have been fixed in this release of Enterprise Studio.
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General

Various example models in Enterprise Studio contained errors
according to the Check & Repair function. These errors have
been fixed.

TP-3066

If the application window is maximized, the window would
freeze after a tool tip was shown when hovering the minimize,
maximize and exit buttons in the top right corner of the window.

TP-3145

The icons in the Create pane were shown in an ugly manner, if
Enterprise Studio was run with customized Windows display
settings.

TP-3346,
TP-3368

Sometimes, when opening multiple model packages using
different metamodels, the dynamic tabs of the ribbon (like
"ArchiMate", "EPM" etc.) would display incorrect texts,
belonging to other menu items.

TP-3384

ArchiMate

Performing the Duplicate objects function in the ArchiMate
ribbon tab would always fail with a script error.*

TP-3236

Enterprise analytics

Sorting a chart after calculating its population could be slow in
case of large populations.

TP-3463

Language and translation

Created PDF posters with Unicode characters in the file name
would not be saved properly.

TP-3031

Changing the model language in the Enterprise Studio Options TP-3134
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did not have a lasting effect. It would return to its default value
on restart of the application.

Sometimes a translation of a custom profile or attribute was
displayed for another profile or attribute, and the original
attribute remained untranslated.

TP-3399

Licensing

At the start-up of Enterprise Studio, when searching for licenses
in an environment that only offers an Advanced license, the
Team Server would first log a failure to detect a license, and
then log success in detecting the Advanced license.

TP-3348

Modeling

Using a hyperlink in documentation (or the "references"
collection) of which the address ended in a large number (such
as 999999999) could crash Enterprise Studio.

TP-1778

The Show Relations function was not able to show relations
that start or end on another relation.

TP-3056

The Automatic Layout and Relation Layout functions could
not cope with the new ArchiMate 3.0 feature dealing with
relations that run from an object to another relation.

TP-3073

When creating a new model via the context menu in the model
browser, the model types were listed in a seemingly random
order.

TP-3271

Scripting

Script methods that output the relations of an object, like TP-3393



8   Enterprise Studio 2.2.0 release notes

Enterprise Studio Release Notes 85

relationsFrom, or need those relations to determine their
output, like objectsWithRole, would sometimes return
incomplete results when applied in tracked or shared model
packages.

Team Platform

When a previous state of a model package was opened from the
package's timeline to view it, the opened model package was
enabled for editing, while it should be read-only.

TP-2941

Running the Activity Console as administrator would interfere
with other user by creating a service available for all users
running Enterprise Studio on the same machine. To prevent this
from happening anymore, the Activity Console will not start
when it is being started as administrator. A message will be
displayed when it happens and the Activity Console will close.

TP-3062

The Forgot password link in the Add Storage Place window
(Enterprise Studio Options) did not work properly, and resulted
in an "Error opening the link" message.

TP-3381

Views and viewpoints

The Generate View for function did not show any available
plateau objects on the View Plateau tab of the Generate View
for window.

TP-2917

In tracked and shared packages, the navigator would not show
relations that were not yet loaded.

TP-3391

View filters (color or label) based upon a relation path (like
those created via the navigator context menu) would sometimes
show incomplete information when applied within a tracked or

TP-3392
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shared model package.

Last updated: 2016-11-23
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9 Enterprise Studio 2.1.1 release notes

For whom?

This release is important for users who work with the Team Platform
functionality "Working together" or "Working together in projects" (Advanced or
Enterprise package).

Bug fixes

The following issues have been fixed in this release of Enterprise Studio.

Team Platform

It was possible to delete a model while it has been checked out
for offline editing by another user, which could lead to data
corruption.

TP-3278

Last updated: 2016-09-19
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10 Enterprise Studio 2.1.0 release notes

For whom?

This release is useful for all users.

A list of known issues can be found online in the Enterprise Studio knowledge
base. If you do not have an account for the BiZZdesign Community to access
the knowledge base, you can request one.

New features and enhancements

The following new features and enhancements have been included in this
release of Enterprise Studio.

General

New Metamodeler
BiZZdesign has developed the Metamodeler. The Metamodeler
can be used by advanced users to customize existing
metamodels. Currently it can be used to create and edit custom
profiles and properties for any metamodel in Enterprise Studio.
Created and customized profiles and properties can be tested,
and then implemented in models stored on the Team Server.

The Metamodeler functionality is available in the Enterprise
Studio Advanced Package and Enterprise package.

TP-3173

Ribbon improvements
Several changes have been made in the ribbon to further
improve the user experience. Ribbon tabs have been renamed
or removed, tab groups have been renamed or relocated, and
commands have been relocated. Most noticeable changes are:

TP-2302,
TP-2303,
TP-2304,
TP-2299,

https://community.bizzdesign.com/BiZZdesign_Enterprise_Studio_Knowledge_Base/index.htm#knownissues/es_known_issues.htm
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l The Edit tab has been renamed to Home, the order of the
groups on the tab has changed, and the Position group has
been renamed to Layout.

l Groups on the View tab have been renamed.

l The Query Tool command has been moved from the View tab
to the Home tab.

l Several Amber model-related view filter commands (like
Organigram and Process Structure) have been moved from
the View tab to the Amber tab.

l The Options tab has been renamed toWindow, and groups
on the tab have been renamed.

l The Help tab has been removed. Most of its commands have
been moved to other tabs or to the Backstage view. The
BiZZdesign Web Site and Help Overview commands have
been removed. An overview of the tool documentation is now
available online in the BiZZdesign Community.

The Enterprise Studio commands reference guide, containing an
overview of relocated commands between
Architect/BiZZdesigner and Enterprise Studio has been updated
to match release 2.1. You can download the Excel file from the
BiZZdesign community. If you do not have an account for the
community, you can request one.

TP-2969

Changed application window title
The caption of the Enterprise Studio application window
displayed too much information. Now the caption displays only
the name of the opened model package or project followed by
the application name. This makes it easier to identify your model
packages and projects when switching between multiple open

TP-2306

https://community.bizzdesign.com/display/DOC
https://community.bizzdesign.com/display/DOC
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application windows.

Renamed model browser pane
The model browser tool pane, which was previously called
"Model Package" or "Project", depending on its contents, has
been renamed to "Model Browser". The name will not change
anymore. The command in theWindow ribbon tab to show and
hide the tool pane has also been renamed to "Model Browser" to
make it consistent with the tool pane.

TP-2307

Updated ArchiMate model templates and example models*
The ArchiMate model templates and example models on the
New tab of the Backstage view have been updated. Redundant
templates and example models have been removed.
Additionally, a new template and example model for Enterprise
Risk and Security Management have been added.

TP-3020
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ArchiMate

Enterprise Risk & Security Management available*
The Enterprise Risk & Security Management (ERSM)
functionality is now available for ArchiMate models. ERSM
includes methods and techniques used by organizations to
manage all types of risks related to the achievements of their
objectives.

Concepts used in ERSM standards and frameworks are mapped
to existing ArchiMate concepts, primarily concepts from the
Motivation extension. By linking risk-related properties to
ArchiMate concepts, risk analysis can be automated. In this way,
it becomes easy to analyze the impact of changes in these
values throughout the organization, as well as the effect of

TP-2237
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potential control measures to mitigate the risks.

Please refer to the Enterprise Studio tool documentation for
more information.

New concepts for Physical view*
The ArchiMate concepts System Software, Technology
Collaboration and Artifact are now available in the Physical
view, which can be used for modeling an ArchiMate model.

TP-2959

Changed role names for the serving relationship*
The role names for the serving relationship have been changed
from "uses" and "used by" to "served by" and "serves", to make it
consistent with the name change of the relationship in ArchiMate
3.0. This may have consequences for user scripts using these
role names.

If you have scripts containing the old role names, you should
change them to the new names: "uses" to "served by", and
"used by" to "serves".

TP-3014
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Enterprise analytics

Show column totals for numerical values table chart
The table chart has been extended with the option to add a row
that shows the total for each column containing numerical
values. The option is accessible via the number format control in
the column formatting bar at the top of the column.

TP-3090

Licensing

Improved license model
BiZZdesign has an improved license model. Previously, a tool
license could consist of separate items, and different
combinations of metamodels, add-ons and product editions,
making it complex sometimes. The new license model is more
transparent and offers more functionality compared to the old
license. The new license model introduces packages and seats.

Packages

TP-2978,
TP-2981,
TP-2982,
TP-2983,
TP-2985,
TP-3013
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The tool features are combined into four types of packages:

l Professional for EA (Enterprise Architecture)

l Professional for BPM (Business Process Modeling)

l Advanced

l Enterprise

A Professional package is always for a single user. The
Advanced and Enterprise packages are meant for multiple
users, run in the network, and support collaboration (Team
Platform).

Seats

Seats apply to the Advanced and Enterprise packages, and they
control the allowed number of active users on the Team Server
(Team Platform functionality). Seats are distinguished into
Manager and Designer seats, determining the (type of) access to
features.

Enterprise Studio can be started with an old tool license
(consisting of an edition, metamodels and add-ons), but if you
wish to work with the Team Platform working together
functionality (use of the Team Server), a new license (containing
a package) has to be available in the network. For more info,
please contact BiZZdesign InSide Sales via telephone number
+31 33 7600280.

License management adapted to new license model
The License Management window in Enterprise Studio has
been renewed in order to match the newly introduced tool

TP-2980
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license model. License management now shows the tool
package and number of seats (users), broken down by type
(designer, manager), in accordance with the purchased license.
Example:

If you have more than one license available, local or in the
network, you can still select what (parts of a) license you wish to
use via the Advanced tab. If one or more packages are
available, you can select which one to use.

License management can be accessed via the Backstage view:
File > About, License management.
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Scripting

New method InternalObject
The scripting language has been extended, the "client"
InternalObject now has a method for getting the temporary folder
using InternalObject("client").tempFolder();

Also, the "client" InternalObject's openPackage() method now
takes to extra boolean parameters, indicating if the package
should be opened in a new window, and whether the package
should keep its URL after being opened.

TP-1908

Team Platform

Improved collaboration messages
Several collaboration messages, that might occur when working
together on a shared model package, have been refined, as to
provide more, and more to-the-point information about what is
going on.

TP-2259

License-related user check on Team Server
The Team Server now checks if the number of (active) users
does not exceed the number of allowed users ("seats") that is
registered in the Enterprise Studio tool license. This applies to
the Enterprise Studio tool packages "Advanced" and
"Enterprise". For the Advanced package, the total number of
users counts. For an Enterprise package, only the active users
(users that are invited to one or more model packages) count.

If too many allowed users are taken - this can happen when
another Team Server in the same network has already taken
users - users have to be made inactive via the Team Server by
revoking their invitations to model packages and projects.

TP-2985
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Alternatively, you could choose to extend your tool license with
more seats (you can contact BiZZdesign InSide Sales for this via
telephone number +31 33 7600280).

As long as the number of allowed users is exceeded, Enterprise
Studio cannot synchronize with the Team Server, which is also
indicated by the Activity Console.

Bug fixes

The following issues have been fixed in this release of Enterprise Studio.

General

Using the search bar of the model browser would cause the
entire model browser tree to be expanded, which caused
significant slowdown in some situations.

TP-2865

The search button (magnifying glass) next to the search field in
the model browser did not correctly perform the search when
clicked.

TP-2849

When installing Enterprise Studio on a machine that did not yet
have the required .NET 4.5 framework installed, the installer did
not detect this and automatically triggered its installation.

TP-2907

The Check and Repair function inadvertently removed part of
the metamodel and resource information from a model package
using embedded metamodels (XMAM, tracked and/or shared
model packages).

TP-2921

Performing actions in parallel in two instances of Enterprise
Studio (i.e. two model packages) sometimes resulted in a crash
of the application.

TP-2940
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The search function (Home > Find > Advanced find) would not
allow searching for objects that have a specific "enum" attribute
without searching for a specific value too.

TP-3034

ArchiMate

Messages given by the ArchiMate 2 to 3 conversion were
improved.*

TP-2706

Several ArchiMate 3.0 relationships have been missing in the
metamodel definition and have been added now.*

TP-2894

The ArchiMate stereotype notation mechanism did not work for
business services, application services, technology services,
and groupings (the stereotype was not displayed on the view).*

TP-2920

BMC

The input form of a sticky note for Cost structures and Revenue
streams (opened via the "Show cost form" or "Show revenue
form" control of the sticky note) did not function properly. Data
could not be added. Also, some values in the input form could
not be edited.*

TP-3063,
TP-3140

Configuration

During the metamodel migration of a model package, default
views of this model package would open, slowing down the
process. These views now remain closed until after the
migration has ended.

TP-3186
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ERD

In ERD logical views, a relationship having multiplicity set to
"many" would not show the appropriate crow's feet at its end
point when this was on a deeper nesting level than the other
end.*

TP-2186

Import and export

After performing a BPMN import from Visio, a subsequent Visio
import to ArchiMate would by default try to use the type mapping
of the BPMN import and vice versa.

TP-2323

The Visio import function showed confusing messages. TP-2702

Language and translation

After changing the application language, the tooltips of the
commands in the Quick Access Toolbar would show captions in
the previous language.

TP-3141

Licensing

In rare occasions, a crash occurred on the Advanced tab of the
License Management dialog.

TP-3148

Modeling

The Compare function did not show the correct changes. TP-1933

The Compare function presented the found differences using
untranslated terms like "objectAdded" and "attributeChanged"
instead of terms in the language that is used in the tool.

TP-1942



10   Enterprise Studio 2.1.0 release notes

Enterprise Studio Release Notes 100

The Compare function allowed comparing a model package to
a model and vice versa.

TP-2118

In very large model packages (with hundreds of thousands of
objects), expanding large parts of the model browser, for
example using the shortcut key ALT+<number>, caused a crash
of Enterprise Studio.

TP-2495

Graphic shapes could appear as search results in the model
browser.

TP-2754

When using Newmultiple to add existing objects to a view, no
new references to the existing objects were added to the view,
even if no such reference was present in the view. From now on,
a reference will be added if there is no other reference to this
object on the view.

TP-2850

The Derived relation types function for ArchiMate models (both
the color view filter and the table variant) no longer displayed
derived relationships.

TP-3059

Performing the automatic layout on a view that contained
relationships that end in relationships, would result in a script
error.

TP-3129

Editing of object names in the model browser or Properties
window could cause corruption if the name contained non-ANSI
characters and was split over multiple lines on the view.

TP-3131

When drawn edges were linked to a message in the Messages
window (for example by a script using the "message"
statement), selecting the message would not highlight the edge
in the view or diagram (like would be the case for objects,
relationships and the other drawing shapes).

TP-3132
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Reporting and printing

The InSite Lite button for generating an InSite Lite report did
nothing when its functionality is not covered by the active
license. Now it shows a dialogue box with information on how to
solve the issue.

TP-2619

In the Print dialog, a selection of views located under the top
level of the views tree would not be printed.

TP-2685

When on a Roadmap view a work package was positioned in
such a way that it was partly outside the borders of the time line,
creating an InSite Lite report of this package would crash the
application.

TP-2935

If a view is referenced on another view, the Diagram tab in the
HTML Settings dialog of the reporting function would show this
view twice.

TP-3122

Scripting

When using a script to create, save and close model packages,
attempting to save or close the model package before it was
actually saved a first time (and a storage location was
established) would cause Enterprise Studio to crash.

TP-2329

When populating a chart using a script that retrieves objects
from an external model package, the model package could no
longer be opened after closing, due to a "closing tag missing"
error.

TP-2526

Team Platform

Accepting all certificates for an HTTPS connection could fail if TP-1809



10   Enterprise Studio 2.1.0 release notes

Enterprise Studio Release Notes 102

another storage place without HTTPS was added to the
available storage places in the Enterprise Studio Options. Also,
valid certificates were rejected if not accepting all certificates of
a storage place.

During the reverting of a model package after claims on the
package were forcibly removed via the Team Server, the mouse
pointer would not show a 'waiting' status.

TP-2744

Clicking on Invitations in the user page menu of the Team
Server did not have any effect. Now it scrolls down to the
invitations section.

TP-2669

In some cases, it was possible to create relationships in read-
only models in a project.

TP-2826

Deleting elements from the source model package during a
large copy/paste action to a copy of the model package makes
Enterprise Studio crash.

TP-2839

It was not possible to revoke a user's invitation in the Team
Server when the Team Server was opened in the Safari web
browser.

TP-2860

Enterprise Studio did not show an error message when
executing the Edit offline function if the Team Server was not
available.

TP-2871

When changing or setting the team data location (where various
data used in the Team Platform functionality are stored), a folder
path containing a drive mapping would be converted to a "UNC"
style path, wherein the drive mapping was replaced by the
actual (server share) location it is pointing to. Now, it is still
allowed to select a path using a drive mapping, but it will be
stored as UNC path (naming is conform the Microsoft naming

TP-2906
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convention for locations of network resources).

In some cases, it was possible to move the contents of read-only
models in a project to other models.

TP-2939

Moving a view filter legend to a different position changed the
model. As of now, if you want the new position to be persistent,
use the "pin" control at the top of the legend in the diagram or
view.

TP-2958

When opening a model package or project for the first time had
failed because the storage place was offline, it could not be
opened anymore.

TP-3001

When committing changes failed, the errors were not always
reported, making it confusing to the user.

TP-3015

Having two or more storage places where the security protocol
differs caused the certificate to be wrongfully rejected.

TP-3026

The dependencies of an object were not correctly updated when
a model package was updated with new contributions.

TP-3035

When modifications were rejected because they conflicted with
changes made by others, only one of the reasons for the
rejection would be shown.

TP-3068

When inviting users in the Team Server, e-mail addresses with
hyphens and apostrophes were not accepted. As of now they
can be used in e-mail addresses.

TP-3088

Sometimes the Activity Console could be blocked in the
following situations: saving a model package on a Team Server,
creating a project, or opening a model package or project for the
first time.

TP-3146
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Views and viewpoints

View filters no longer worked on collapsed objects. TP-3028

* The issue has resulted in a changedmetamodel configuration. If you havemodel
packageswith thismetamodel embedded (.xmam) and/or model packages stored in
your personal storage or on the TeamServer (TeamPlatform), you need tomigrate
them tomaterialize the change or fix in this release. For instructions, please refer to
the Enterprise Studio Update Guide.

Last updated: 2016-08-31
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11 Enterprise Studio 2.0.0 release notes

For whom?

This release is useful for all users.

Attention: To support your upgrade from Architect or BiZZdesigner to
Enterprise Studio, accompanying documentation is available, describing all
relevant information and the steps you need to perform to migrate to the
new tool. The documentation is available online, in the BiZZdesign
Community. If you do not have a user account for the community yet, you
can easily request one on site.

A list of known issues can be found online in the Enterprise Studio knowledge
base. If you do not have an account for the BiZZdesign Community to access
the knowledge base, you can request one.

New features and enhancements

The following new features and enhancements have been included in this
release of Enterprise Studio.

General

Single Document Interface
Enterprise Studio is a Single Document Interface application,
meaning that only one model package is opened per instance of
the tool. Each model package has its own program window. This
is different from Architect and BiZZdesigner, which are Multiple
Document Interface applications; all model packages open in
one program window.

https://community.bizzdesign.com/BiZZdesign_Enterprise_Studio_Knowledge_Base/index.htm#migr_mps/mp_migr.htm
https://community.bizzdesign.com/BiZZdesign_Enterprise_Studio_Knowledge_Base/index.htm#knownissues/es_known_issues.htm
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This document centered approach makes it much clearer for the
user in what context operations are performed, since there is
only one model package per window. In the old tools, operations
could be performed in the view windows, as well as in the model
browser; which could be leading to confusion because the focus
of these windows determines what the target for a particular
function will be.

Introduction of the Backstage view
Enterprise Studio introduces the Backstage view. The
Backstage view, well-known from Microsoft® software, is where
you manage your model packages, view relevant model
package data and perform actions such as opening, saving and
creating model packages. You can also access the tool's options
(former application settings) and help. The Backstage view
replaces the former File menu, and can be accessed by clicking
the File tab in the ribbon.

TP-2316,
TP-2298,
TP-2305
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For a complete overview of the former File menu commands and
their new location in the Backstage view, download the
Enterprise Studio commands reference guide (Excel file)
from the BiZZdesign community.

Relocation ribbon commands and removal of toolbars in Enterprise Studio
A number of ribbon commands have been relocated in
Enterprise Studio. Part of them are now located in the Backstage
view (see previous item), others have been relocated in the
ribbon, like the import an export commands, tables, and some of
the view filters.

Several toolbars that were present in Architect and
BiZZdesigner, are no longer available in Enterprise Studio. A lot
of the functions in the different toolbars were already present in
the ribbon or application status bar. The rest of the functions
have been relocated in Enterprise Studio, or removed because
they are no longer used.

For a complete overview of the relocated commands and toolbar
functions, download the Enterprise Studio commands
reference guide (Excel file) from the BiZZdesign community.

TP-1097,
TP-1472

https://community.bizzdesign.com/display/DOC
https://community.bizzdesign.com/display/DOC
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Team Platform replaces Team Support and working with database model packages
The new Team Platform functionality in Enterprise Studio
replaces the old Team Support and Repository functionality in
Architect and BiZZdesigner. The Team Platform functionality
offers tracking progress of your model packages, and working
together on model packages and projects.

Tracking progress

By tracking progress of your model packages you can keep track
of the development of your model packages. All changes made
to a model package are shown in a timeline. You can see at any
time what changes have been made.

Working together
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When working together on model packages you contribute
together with other users to model packages that are stored on a
central location called the Team Server. Users share model
packages and committed changes are directly shared between
the participants by means of synchronization. Each participant
has the possibility to include the contributions of others in the
local copy of the model package. When working together on a
model package, progress is also automatically tracked.

Working together on projects offers the possibility to collaborate
on parts of a model package instead of an entire model package.
This type of collaboration is the same as working on model
packages; projects are stored on the Team Server and are
shared between users that can contribute.

Team Server

The Team Server is the central storage place for shared model
packages and projects, and a management environment for thee
packages, projects and the participating users.
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Activity Console

For the registration of all actions performed within the context of
the Team Platform functionality, Enterprise Studio uses the
Activity Console. The Activity Console registers all activities that
have been performed when working together on model
packages and projects. The Activity Console can be accessed
via the system tray of your computer.

ArchiMate

ArchiMate 3.0 release*
ArchiMate 3.0 has been released by The Open Group.
ArchiMate 3.0 contains many changes and improvements,
including the following:

TP-1756
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l New elements (e.g. Strategy and Physical elements, elements
in Application Layer)

l Renamed elements (e.g. Technology Layer elements)

l Relocated elements (e.g. Value and Meaning from Business
Layer to Motivation elements)

l Renamed relationships (e.g. Used By -> Serving)

l Restructured set of relationships into the categories structural,
dynamic, dependency, and other.

For detailed information about the changes between ArchiMate
2.1 and ArchiMate 3.0, please refer to the website of The Open
Group.

An overview of the changes in elements in ArchiMate 3.0
compared to ArchiMate 2.1 can be downloaded from the
BiZZdesign Community.

A quick reference with the ArchiMate 3.0 concepts in Enterprise
Studio can be downloaded from the BiZZdesign Community.

Configuration

Metamodel versioning no longer needed for customizing configuration*
In Architect and BiZZdesigner, metamodels were versioned.
After customizing the configuration, manifest files needed to be
updated to give the metamodels a new version when working
with repository model packages. Metamodel versioning is no
longer needed in Enterprise Studio.

After changing your configuration files, you can directly put the
customized configuration into use by selecting the configuration
at the configuration settings in the tool and restarting the tool

TP-1501

http://www.opengroup.org/
http://www.opengroup.org/
https://community.bizzdesign.com/display/DOC
https://community.bizzdesign.com/display/DOC
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while loading the new configuration. After that any shared model
packages need to be migrated to the new configuration (see next
item).

Migrating model packages to a new configuration
Changes made to the metamodel configuration can be made
effective for model packages stored on the Team Server.

Globally, the new migration function consists of following steps:

1. Opening of the shared model package that needs to be
migrated to the new configuration.

2. Execution of the migration function.

3. Commit of the changed configuration to the Team Server.

4. Distribution of the configuration commit via the Team Server
to all shared model packages, projects and currently open
working copies.

When executing the migration function, the embedded
configuration of the active model package will be adapted to the
new configuration. The new migration function is available at the
configuration options, accessible via File > Options in the
Backstage view.

TP-2352,
TP-2353,
TP-2354,
TP-2355
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There are a few restrictions to the migration functionality:

l Removal of profiles or profile attributes, or changing the type
of an attribute is not allowed.

l Removal of viewpoint definitions is not allowed.

In case of any of the above, migration of a model package will
not be possible.
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For detailed information about the migration procedure, please
refer to the Enterprise Studio tool documentation.

Import and export

Transform XML functionality for XMI import removed
Previously, the XMI import function for Amber and ArchiMate
model data supported converting XML files to the standard
Architect XML exchange format as an intermediate step in the
import process. This was done using the Transform XML
function. This function is no longer available. As of now when
performing an XMI import, you just need to select a file with the
standard Architect XML exchange format and import it.

TP-1191

ArchiMate export functionality temporarily deactivated
The ArchiMate export functionality has temporarily been
removed from Enterprise Studio in order to make it compliant
with the newly released ArchiMate 3.0 standard.

TP-2627

Licensing

Working offline
If a user is working on a network license, but wishes to work
offline, the user is now able to temporarily work offline by taking
the license offline in the Enterprise Studio License Management.
The entire license will be moved to the local machine and the
user can work offline. A license can be taken offline for a
maximum of 14 days. After that the offline license must be
returned in order to be able to continue working with Enterprise
Studio.

TP-1552

https://community.bizzdesign.com/Enterprise_Studio_Help_-_EN/index.htm#advanced/adv_process_config_changes_in_mps_and_projects.htm
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Modeling

Enhanced object search
Searching for objects in the model browser and the object
selector has been enhanced. Upon entering text to search for,
the number of expected hits is shown within the text field. In
addition, the time needed to find matching objects has been
reduced, so that even on large models it will respond quickly.

TP-1150

New cross-reference table for cross-model relationships
In addition to the relation cross-reference there is the cross-
model relation cross-reference table, a table for showing and
editing relationships between elements in models of different

TP-1154,
TP-2240
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metamodels. Example:

With the introduction of the new cross-reference table, the cross-
reference table commands in the ribbon have been regrouped.
All three cross-reference tables can now be accessed via Edit >
Cross-Reference Table and then Profiles, Relations, or
Cross-Model Relations.
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Changed scope selection options Link table and CRUD matrix
To protect against issues of low performance when opening the
Link table or CRUD matrix (only for Amber models) on a very
large model package as a whole, it is no longer allowed select
the model package as the table's context. The scope can now be
set to active diagram (default option) or current selection.

TP-1157

Scripting

fqnmethod removed
The fqn method has been removed from the scripting language
because it no longer has any significance in Enterprise Studio;
the method could specifically be used for Architect or
BiZZdesigner with EMS.

Users that have included the method in their scripts will see a
message on the screen indicating that the method is deprecated
when the method is used.

TP-1059

UML

Support for modeling sequence diagrams*
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The UML modeling language in Enterprise Studio now also
supports Sequence Diagrams. Sequence Diagrams can be used
to specify interactions between components (objects or actors) in
a (software) system in detail by focusing on the sequence of
messages that are exchanged between their lifelines.

TP-1796

Bug fixes

The following issues have been fixed in this release of Enterprise Studio.

General

The Check and repair function was missing a check for
mismatches between the graphic and reference hierarchies.

TP-1770

When clicking the More commands in the Quick Access
toolbar of the application, the application would crash.

TP-1773

In some occasions the application window did not appear after TP-2440
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the tool had been started, although a tool process seemed to be
running.

Amber

In a read-only Amber model it was possible to edit the attributes
of an activity, the condition of an enabling relationship, and the
attributes and operation of a data type. This is no longer
possible.*

TP-1798

BPMN

Removing Data Input or Data Output objects from a BPMN
Process diagram would sometimes produce a script error.*

TP-1682

The comment symbol in the BPMN Choreography and
Resources diagrams did not look like the common BPMN
comment symbol. Now it does.*

TP-1772

Running the Check processes function on a BPMN Process
diagram containing a Call Activity, referring to a Global Task
and enabling a Gateway, would produce a script warning.*

TP-1885

When the same Data Store was added to a Process or
Collaboration diagram multiple times, and Associations were
drawn from these references to another object, multiple
references were added for these Associations, all drawn on top
of each other.*

TP-2314

Configuration

Enterprise Studio ignored profiles defined in a high-level
metamodel (like ArchiMate or Amber), but assigned to a type

TP-1337
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defined in the metamodel "MM_ModelPackage" (like MM_
ModelPackage or MM_Folder).

Enterprise analytics

When populating a chart with a model containing viewpoints
stored in folders, a script error could occur when refreshing the
chart.

TP-2145

Enterprise Portfolio Management

Removing a metric object using CTRL+D would incorrectly
raise the message "The object you selected, or one of its
children, is still referred to by other objects." Metric objects
always have a dependency with themselves when trying to
delete them from the model using CTRL+D.*

TP-1774

ERD

When dropping ERD objects with cross-model relationship, a
script error would occur.*

TP-1884

Language and translation

Special (Slovak) characters were not displayed in objects in the
view in certain situations.

TP-1775

After adding a new language to a model package and copying
the texts from another language, certain diagrams (like Amber
behavior diagrams, or BPMN process diagrams) would show a
generic type name on the diagram's window tab, instead of the
correct name displayed in the model browser.

TP-1975
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Lean

In a Lean model, the title of the elements in the SIPOC view
were not translated to the currently set language.*

TNG-
6422

Licensing

In license management, after deactivating a feature, this feature
was correctly disabled, but the tool kept claiming a license for it.

TP-1736

With the license for the "UML" metamodel deactivated, it was no
longer possible to create and edit UML diagrams within the
"Amber" metamodel, not even when the license for this add-on
was active.

TP-1998

Modeling

The Link table was very slow when used in large model
packages.

TNG-
6261

Money values were not rounded up when displayed in the
Properties window.

TP-1358

The Link table did not correctly respond to changes that had
been made in the model. Now, the Link table has a Refresh
button that can be used to update the table whenever links in
the model are changed.

TP-1457

After changing an item relationship's type using the CRUD
matrix (Amber models), the associated text in the undo list
(Quick-access toolbar, command Undo) did not specify what
was changed, but instead just said "Set CRUD".

TP-1835

Moving the endpoint of an edge from one object to another
would move it visually, but left the edge still connected to its

TP-2001
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original end object.

Performing an automatic layout on a view that shows a
relationship containing a backslash in its name would result in
an error.

TP-2321

Reporting

When reporting viewpoints that require user interaction, these
viewpoints did not raise their mandatory confirmation question
when they were located in a viewpoints collection that was
collapsed.

TP-1473

When moving a view filter legend to the back of an object in a
shared view, a crash occurred when generating an HTML
report.

TP-1771

When creating an InSite Lite report with some views
deactivated, some pages of the report were missing certain
information.

TP-1820

Scripting

The getObject script method has been optimized to retrieve
objects by name much faster.

TP-1866

For scripts that write output to text files, did no longer properly
encode those files because the default character encoding has
changed to UTF-8.

To restore the old character encoding (the default system code
page), a parameter statement should be used for the parameter
"encoding" with the value "ACP". Note that the value "NONE" is
now equivalent with "UTF-8".

TP-1910
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UML

When dropping UML objects with cross-model relationships, a
script error would occur.*

TP-1884

In a UML model, it was possible to create circular relationships
(relationships referring back to the objects they start from), which
would cause a crash when such relationships were moved.*

TP-1984

When removing the name of a UML Association the
accompanying direction arrow remained.*

TP-2349

Views and viewpoints

In the Tooltip view, hovering with the mouse cursor over a tooltip
would sometimes (re)draw a blank tooltip.

TP-1444

The Execute Viewpoint function in the context menu was not
available when trying to access the function on objects in
another model within the same model package.

TP-1768

* The issue has resulted in a changedmetamodel configuration. If you havemodel
packageswith thismetamodel embedded (.xmam) and/or model packages stored in
your personal storage or on the TeamServer (TeamPlatform), you need tomigrate
them tomaterialize the change or fix in this release. For instructions, please refer to
the Enterprise Studio Update Guide.

Last updated: 2016-11-22
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12 Enterprise Studio 0.91 release notes

For whom?

This release is useful for all users.

New features and enhancements

The following new features and enhancements have been included in this
release of Enterprise Studio.

General

Single Document Interface
Enterprise Studio is a Single Document Interface application,
meaning that only one model package is opened per instance of
the tool. Each model package has its own program window. This
is different from Architect and BiZZdesigner, which are Multiple
Document Interface applications; all model packages open in
one program window.

This document centered approach makes it much clearer for the
end-user in what context operations are performed, since there
is only one model package per window. In the old tools,
operations could be performed in the view windows, as well as
in the model browser; which could be leading to confusion
because the focus of these windows determines what the target
for a particular function will be.

Backstage view
The former File menu as we know it in Architect and
BiZZdesigner, has been replaced by a Backstage view in
Enterprise Studio.
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The Ribbon contains the set of commands for working in a
model package, while the Backstage view is the set of
commands you use to do things to a model package. It
resembles the Backstage view in Office applications. In the
Backstage view you manage your model packages and their
related data, including open, create, save, and send model
packages and set options such as changing the tool language ,
and more.

Modeling

Changes in comparing models
Because Enterprise Studio is now a Single Document Interface
application, the compare function has slightly changed.

The Compare function is located in the Show group of the View
ribbon tab.

Comparing models within one model package

This works the same as before. Select two models within one
model package in the model browser and click Compare in the
ribbon. The regular dialog for comparing models appears.

TP-1233
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Comparing models in different model packages

This works a little different than before. Make sure that the two
model packages with the models you want to compare are open,
each model package appears in its own tool window. In one of
the two model packages, click on the model you want to
compare and click Compare in the ribbon. In the first dialog for
comparing models, select the model in the other model package
you want to compare to. After clicking OK, the regular dialog for
comparing models appears.

Once a model is selected for comparing, its tool window will be
frozen for a correct comparison. In case the respective tool
window is busy due to other operations, a message will be
displayed.

Scripting

Type names must be quoted
From this version onward it is no longer possible to use literal,
unquoted type names in script statements, for example forall
BusinessActor x in ..... This construct has been deprecated for
some time now, resulting in a warning, but still executing the
script correctly.

Starting with this version you need to use a quoted type name
(or a type expression): forall "BusinessActor" x in ....

TP-1442

TeamPlatform

Performance improvements
Shared model packages now take up less disk space. TP-458

Possibility to accept Team Server certificates
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It is now possible to configure the option to accept all certificates
of HTTPS-enabled Team Servers. To do this, select the Accept
all server certificates check box when adding the Team Server
to your application.

If you do not accept all certificates, and the certificate is self-
signed, expired or otherwise invalid, you'll get a error message
about this, and you can change the setting to accept the
certificates.

Once a certificate has been accepted you cannot revert this
acceptance unless you restart the Activity Console and clear the
Accept all certificates check box before restarting.

TP-575

Team Server password complexity check
The password that must be entered for accessing the Team
Server is now bound to a complexity check. The password
needs to be at least 6 characters. Additionally, a suggestion to
improve the password strength is given with a visual indicator
and some tips.

TP-720

Change in storing model package working copies
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There has been a change in the way the local copies of model
packages are saved.

If you are encountering problems with opening or saving model
packages, please close the tool and the Activity Console. Next,
look up the directory c:\users\<username>\AppData\Roaming
and delete the directory BiZZdesign. After that all should be
working again. Note that the model packages in your local
storage will be deleted with this action.

TP-998

Security improvement for accessing Team Server
If after 5 attempts a user does not successfully log in on the
Team Server, the user will be blocked for 30 seconds before
being able to try again.

TP-1066

Bug fixes

The following issues have been fixed in this release of Enterprise Studio.

General

When opening a model package via the command line or via
drag-and-drop on the tool icon, the model package was opened
twice in different windows.

TP-1057

Special characters in model package contents were sometimes
displayed in a wrong way in views and in the model browser.

TP-1199

Modeling

When using the Paste Special function on a selected object,
the object being pasted into the selected object was positioned
outside the selected object.

TP-908
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The Undo changes function was available in read-only
models.

TP-966

Opening the context menu of a model package in the model
browser could take a long time.

TP-1009

It was possible to save a model package with the extension
.jssc.

TP-1039

When the Link table was used to bulk change link addresses,
these links would be added to the table a second time.

TP-1357

Scripting

The relatedTo function returned incorrect results for a relation
ending on a relation.

TP-1252

A crash occurred when attempting to cancel a viewpoint save
operation in the naming dialog of the Querytool.

TP-1470

Canceling the saving of a viewpoint in the Querytool would still
save the viewpoint.

TP-1526

TeamPlatform

When a user withdrew from a shared model package, not all
data pertaining to that model package was deleted.

TP-894

When using special characters (for example &, <, >, " or ') the
tool would display data incorrectly. It would not show anything
or it would show raw XML code instead of proper text. This
would happen when using special characters in for example
commit messages.

TP-922,
TP-991

When adding users to the Team Server without having admin TP-924
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rights, no model packages were visible to invite the user to.

When using the Team Server website in two different tabs in the
web browser, logging out in one of the tabs and then trying to
use the website in the other tab, the user would be redirected to
the login page and see an error message stating that the user is
already logged in, and the menu bar would still show the user
as logged in.

TP-959

Opening the Backstage view and selecting a storage place
containing multiple model packages on the Open tab would
take a noticeable amount of loading time. Also, accessing the
Work together tab of the Backstage view would take too much
loading time.

TP-977

In the tool, it was possible to change the name of a user linked
to a storage place, which could cause problems in the
registration of changes to model packages made by the user. As
of now only the user's e-mail address can be changed in the
tool, the link between a user's name and the storage location
cannot change.

TP-989

After checking out a model for offline editing, the tool would
show an error message that was unclear to the user. The
message now refers to the model that is checked out and
provides a better description of what needs to be done.

TP-1013

When the Activity Console was not running (anymore) or not
responding, an error message about this was given repeatedly.

TP-1027

The Team Server would create temporary files for data transfer,
which were not properly cleaned up by the tool after the tool had
consumed the data, leading to a growth of files in the temporary
folders on the user's computer.

TP-1033
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After receiving a message stating an object was out of date, and
accessing the Update tab in the Backstage view to perform the
necessary refresh action, there were no commits displayed to
refresh.

TP-1037

When installing the Team Server, and the installation files were
not on the same drive as the windows installation, the
installation scripts would fail, causing the installation to fail.

TP-1043

After undoing changes to a model package, views could show
incorrect information.

TP-1047

Saving a model package in the Team Server could temporarily
freeze other instances of the tool while the saving operation was
in progress.

TP-1056

Model packages saved in a (personal or external) storage place
have a tooltip with information regarding most recent
contributions and the number of contributions the model
package is behind. Showing this tooltip caused a noticeable
delay in loading the list of model packages on the Open tab of
the Backstage view.

TP-1079

A model package created with an innovation configuration could
be saved to a personal storage or a Team Server.

TP-1083

When the "Working together" license feature had been active in
an earlier tool release, but was no longer available in the 0.9
release, shared model packages could still be opened fully
editable when opening them via File > Open > Recently
opened.

TP-1119

After logging out of the Team Server admin pages, an
"unauthorized error" was given.

TP-1251
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When opening a link to the Team Server registration page (from
the invitation e-mail), the page remains blank in Internet
Explorer and FireFox.

TP-1524

When Enterprise Studio has been configured to run on a
network license, and for some reason the network license server
was not available, the tool could crash on startup.

TP-1547

* The issue has resulted in a changed metamodel configuration. Model
packages with the metamodel embedded (.sma, .xmam, repository model
packages) need to be migrated to materialize the change or fix.

Last updated: 2015-12-10



Contact BiZZdesign

Service desk For questions and information regarding service and support.
Portal: https://service.bizzdesign.com/servicedesk

Community http://community.bizzdesign.com

Academy For questions and information regarding training and education.
Phone: +31 - 33 - 7 600 284
E-mail: academy@bizzdesign.com

Inside sales For questions and information regarding commercial conditions,
new modules, and prices for use.
E-mail: sales@bizzdesign.com

Head office For general questions and information.
Phone: +31 - 53 - 4 878 151
E-mail: info@bizzdesign.com

Website http://www.bizzdesign.com
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